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Using your Study Guide 
Welcome to the study guide, designed to support you in completing your Level 4 Diploma in 
Information Technology. 

 
This study guide follows the order of the syllabus, which is the basis for your studies. Each 
chapter starts by listing the syllabus learning outcomes covered and the assessment criteria. 

 

Level 4 Units 

 

 
The study guide includes a number of features to enhance your studies: 

 

📝 'Over to you:' activities for you to apply what you have learned. 

🌍 'Industry Insights:' discover up-to-date trends, expert opinions, and real-world 
examples from leading organisations in the IT and creative industries. 

🧭 'Did you know?' highlights interesting facts or surprising information to deepen 
your understanding. 

💼 'Case studies:' realistic business scenarios to reinforce and test your 
understanding. 

📱 'Revision on the go:' use your phone camera to capture key pieces of learning 
and save them as revision notes. 

❗ 'Need to know:' key pieces of information highlighted in the text. 

💡 'Examples:' illustrating points made in the text to show how it works in 
practice. 

 
Note: Website addresses current as of March 2026. 
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Level 4 Computer Graphics Editing and Database 
Concepts 

About this unit 

This unit aims to explain the concepts of photo editing and enable you to insert photos into 
documents such as user manuals and organisational IT materials. Photos often need to be 
touched up, retouched, or repaired before they are ready for professional use. You will 
primarily use Adobe Photoshop for photo and image editing, and Adobe Illustrator for 
vector-based design and illustration. The unit delivers skills in photo retouching, digital 
drawing, and graphic design, emphasising exploration, techniques, media, ideas 
development and production techniques. 

 
This unit also provides the fundamental concepts of database systems through Database 
Management Systems (DBMS), relational databases, entity-relationship modelling and 
normalisation. You will also learn to create and manipulate database systems using 
Structured Query Language (SQL), including both Data Definition Language (DDL) and Data 
Manipulation Language (DML). 

 
By the end of this unit, you will be confident in both visual communication through graphic 
design and data management through relational databases – two essential competencies for 
any IT professional. 
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Chapter One – Computer Graphics Editing Techniques 

Introduction 

This chapter explores the practical skills of computer graphics editing, from photo retouching 
and repair to creating original illustrations and animations. In the modern IT landscape, 
visual communication is as important as technical skill. Whether you are designing a user 
interface, preparing images for a website, creating marketing materials, or documenting an 
IT system architecture, the ability to work confidently with graphic editing tools is invaluable. 

 
You will learn to use Adobe Photoshop – the industry-standard raster graphics editor – for 
photo correction, retouching, layer-based compositing, and applying creative effects. You will 
also use Adobe Illustrator – the leading vector graphics editor – to create scalable 
illustrations, logos, icons, and typographic designs. Finally, you will explore techniques for 
creating movement and animation in graphical environments. 

 
Hands-on practice is essential for this chapter. You are encouraged to follow along with the 
video tutorials and complete the practical activities using the software described. 

 

Learning Outcomes 

On completing the chapter, you will be able to: 

1.​ Use computer graphic editing techniques to edit photos and create illustrations. 

 

Assessment Criteria 

1.1 Apply photo editing, retouching and repairing techniques correctly. 

1.2 Use Photoshop correctly to create the required effects. 

1.3 Create illustrations using illustration software tools to the required standard. 

1.4 Analyse techniques to create movement in a graphical environment. 
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1.1 Photo editing, retouching and repairing techniques 

📝 Over to you – Video Watch: Photoshop for Beginners 

Watch this YouTube video: 
Title: Photoshop Tutorial for Beginners 2024 – Everything You NEED to KNOW! – Envato 
Tuts+ 
Duration: 36:57 
Link: https://www.youtube.com/watch?v=IyR_uYsRdPs 

Watch the first 15 minutes covering the workspace, tools, and basic operations. Note 
down the names and functions of five tools from the toolbar. Which tool do you think you 
will use most frequently? 

 
Understanding Digital Images 

Before you can effectively edit photos, you need to understand the fundamental properties of 
digital images. A digital image is made up of tiny coloured squares called pixels (picture 
elements). The key properties include: 

•​ Resolution – the number of pixels in an image, typically expressed as width × height 
(e.g. 1920 × 1080 pixels). Higher resolution means more detail but larger file sizes. 
Print resolution is measured in dots per inch (DPI), with 300 DPI being the standard 
for high-quality print and 72 DPI typical for screen display. 

•​ Colour mode – determines how colours are represented. RGB (Red, Green, Blue) is 
used for screen display, while CMYK (Cyan, Magenta, Yellow, Key/Black) is used for 
print. Grayscale uses shades of grey only. 

•​ Bit depth – the number of bits used to represent each pixel’s colour. An 8-bit image 
supports 256 colours per channel; a 24-bit image (8 bits × 3 channels) supports over 
16 million colours. 

•​ File formats – JPEG (lossy compression, small files, ideal for photographs), PNG 
(lossless compression, supports transparency, ideal for web graphics), TIFF 
(lossless, large files, used in professional printing), PSD (Adobe Photoshop native 
format, preserves layers and editing information), RAW (unprocessed camera data, 
maximum editing flexibility). 
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🧭 Did you know? 

The first digital photograph was taken in 1957 by Russell Kirsch at the National Bureau of 
Standards. It was a 176 × 176 pixel image of his infant son. Today, a standard smartphone 
camera captures images of 12–50 megapixels – each one containing millions of 
individually addressable colour values. 

 
The Photoshop Workspace 

Adobe Photoshop’s workspace consists of several key components that you need to 
understand before you can work effectively: 

•​ Menu bar – provides access to all Photoshop features organised by category (File, 
Edit, Image, Layer, Type, Select, Filter, 3D, View, Window, Help). 

•​ Options bar – displays settings specific to the currently selected tool. This changes 
dynamically as you switch tools. 

•​ Tools panel – a vertical toolbar on the left side containing all editing tools, grouped by 
function. Tools include selection tools (Marquee, Lasso, Magic Wand), painting tools 
(Brush, Eraser, Gradient), retouching tools (Clone Stamp, Healing Brush, Patch), and 
shape/text tools. 

•​ Panels – additional windows (Layers, History, Properties, Colour, Swatches, etc.) that 
provide information and controls for specific functions. Panels can be docked, 
grouped, and customised. 

•​ Canvas – the main working area where your image is displayed. 
•​ Workspace presets – Photoshop offers preset workspace layouts (Essentials, 

Photography, Painting, etc.) optimised for different workflows. You can also save 
custom workspace layouts. 

 
Photo Corrections 

Photo correction involves adjusting the fundamental properties of an image to improve its 
overall appearance. Common corrections include: 
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•​ Brightness and contrast – adjusting the overall lightness/darkness and the range 
between the lightest and darkest tones. Use Image > Adjustments > 
Brightness/Contrast, or for more control, use Levels (Ctrl+L) or Curves (Ctrl+M). 

•​ Colour balance – correcting unwanted colour casts (e.g. a photo that appears too 
blue or too yellow). Use Image > Adjustments > Colour Balance or the more powerful 
Camera Raw Filter. 

•​ Hue/Saturation – adjusting the overall colour (hue), intensity (saturation), and 
lightness of the image or specific colour ranges. Use Image > Adjustments > 
Hue/Saturation (Ctrl+U). 

•​ White balance correction – ensuring that white objects appear truly white, correcting 
for different lighting conditions (daylight, tungsten, fluorescent). 

•​ Cropping and straightening – removing unwanted areas and correcting tilted horizons 
using the Crop Tool (C). 

•​ Sharpening – enhancing edge definition to make the image appear sharper. Use 
Filter > Sharpen > Unsharp Mask for precise control. 

•​ Noise reduction – reducing the grainy texture that appears in images taken in low 
light or at high ISO settings. Use Filter > Noise > Reduce Noise. 

 
Photo Retouching and Repairing 

Retouching goes beyond basic correction to remove imperfections, repair damage, and 
enhance specific elements of an image. Key retouching tools and techniques include: 

•​ Clone Stamp Tool (S) – copies pixels from one area to another, useful for removing 
unwanted objects or filling in missing areas. Alt+click to set the source point, then 
paint over the target area. 

•​ Healing Brush Tool (J) – similar to the Clone Stamp but automatically blends the 
copied pixels with the surrounding area, producing a more natural result. Excellent 
for removing blemishes, spots, and small imperfections. 

•​ Spot Healing Brush – automatically analyses the surrounding area and fills in the 
selected spot. No source point needed – simply paint over the imperfection. 

•​ Patch Tool – allows you to select an area and drag it to a ‘good’ area to use as the 
replacement. Useful for larger repairs. 

•​ Content-Aware Fill – Photoshop’s AI-powered tool that intelligently fills selected areas 
based on surrounding content. Select an area > Edit > Content-Aware Fill. Extremely 
powerful for removing objects from backgrounds. 

•​ Red Eye Tool – removes the red-eye effect caused by camera flash reflecting off the 
retina. 

•​ Dodge and Burn Tools – lighten (dodge) or darken (burn) specific areas of an image. 
Used subtly for portrait retouching and adding depth. 

 

🌍 Industry Insight – Photo Editing in Professional Practice 
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Photo editing skills are essential across many IT and creative roles. Web developers edit 
images for responsive websites, ensuring they load quickly without sacrificing quality. UX 
designers create and modify mockups and prototypes. IT documentation specialists 
prepare screenshots and diagrams for user manuals. Marketing teams edit product photos 
for e-commerce platforms. According to a 2024 survey by Creative Bloq, Adobe 
Photoshop remains the most widely used professional image editing tool, with over 90% of 
creative professionals using it regularly. 

Explore: Adobe’s official Photoshop tutorials at 
https://helpx.adobe.com/uk/photoshop/tutorials.html 

 

📝 Over to you – Retouching Practice 

Download a free stock photo from https://unsplash.com/ that has visible imperfections 
(e.g. dust spots, blemishes, an unwanted object in the background). Using Photoshop (or 
the free alternative GIMP), apply the following techniques: (1) correct the brightness and 
contrast, (2) adjust the colour balance, (3) use the Clone Stamp or Healing Brush to 
remove at least one imperfection, (4) crop and straighten the image, and (5) save the final 
result as both a PSD and a JPEG. Document each step with before/after screenshots. 
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1.2 Using Photoshop to create effects 

Beyond basic correction and retouching, Photoshop is a powerful creative tool capable of 
producing sophisticated visual effects. This section explores layers, masks, channels, filters, 
and typographic design – the building blocks of creative Photoshop work. 

 

📝 Over to you – Video Watch: Photoshop Layers Explained 

Watch this YouTube video: 
Title: Photoshop Layers Explained for Beginners – Photoshop Training Channel 
Duration: 22:04 
Link: https://www.youtube.com/watch?v=yjGGCq6hmUI 

After watching, explain what a layer is and why layers are essential for non-destructive 
editing. What is the difference between a background layer and a regular layer? 

 
Working with Layers 

Layers are perhaps the most important concept in Photoshop. A layer is like a transparent 
sheet on which you can place image elements. By stacking multiple layers, you can create 
complex compositions without permanently altering the original image. This is called 
non-destructive editing. 

 
Key layer concepts include: 

•​ Layer types – pixel layers (contain raster image data), adjustment layers (apply 
colour/tone adjustments non-destructively), text layers, shape layers, and smart 
objects (preserve source data for non-destructive transformations). 

•​ Layer order – layers higher in the Layers panel appear in front of layers below them. 
You can reorder layers by dragging. 

•​ Opacity and blending modes – opacity controls the transparency of a layer (0% = 
fully transparent, 100% = fully opaque). Blending modes (Normal, Multiply, Screen, 
Overlay, etc.) control how a layer’s pixels interact with the pixels below. 

•​ Layer groups – organise multiple related layers into folders for easier management. 
•​ Layer styles – pre-built effects (drop shadow, bevel and emboss, stroke, glow, etc.) 

that can be applied to any layer. 
•​ Clipping masks – confine the content of one layer to the shape of the layer below it. 
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Masks and Channels 

Masks control the visibility of specific areas of a layer without permanently deleting pixels. A 
layer mask is a grayscale image attached to a layer: white areas are visible, black areas are 
hidden, and grey areas are partially visible. This allows extremely precise, non-destructive 
control over which parts of a layer are shown. 

 
Channels represent the individual colour components of an image. An RGB image has three 
channels (Red, Green, Blue), each showing the intensity of that colour across the image. 
You can also create alpha channels, which are custom selections stored as grayscale 
images. Channels are particularly useful for creating complex selections (e.g. selecting hair 
against a background) and for advanced compositing work. 

 

🧭 Did you know? 

The concept of layers in digital image editing was pioneered by Photoshop in version 3.0 
(1994). Before layers, every edit permanently altered the image, making experimentation 
risky and undo limited. The introduction of layers revolutionised digital design and is now a 
fundamental feature of virtually every professional image editing application. 

 
Filters and Effects 

Photoshop includes hundreds of filters that apply visual effects to images. Key filter 
categories include: 

•​ Blur filters – Gaussian Blur (smooth, even blur), Motion Blur (simulates camera or 
subject movement), Lens Blur (simulates shallow depth of field). Used for 
background softening, creating depth, and simulating camera effects. 

•​ Sharpen filters – Unsharp Mask and Smart Sharpen enhance edge definition. 
Essential for preparing images for print or web. 
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•​ Distort filters – Liquify (reshape and warp image areas), Spherize, Twirl. Used for 
creative effects and retouching (e.g. subtly reshaping objects). 

•​ Stylize filters – Find Edges, Emboss, Oil Paint. Transform photographs into artistic 
interpretations. 

•​ Noise filters – Add Noise (add texture or grain) and Reduce Noise. 
•​ Filter Gallery – provides a visual preview of artistic, brush stroke, distort, sketch, 

texture, and other filters, allowing you to combine multiple effects. 
•​ Smart Filters – when a layer is converted to a Smart Object, filters are applied 

non-destructively and can be adjusted or removed at any time. 
 
Typographic Design 

Typography – the art and technique of arranging type – is a critical element of graphic 
design. Photoshop provides powerful text tools for creating headings, body text, logos, and 
typographic compositions: 

•​ Horizontal and Vertical Type Tools (T) – create point text (single line) or paragraph 
text (text box with wrapping). 

•​ Character panel – control font, size, leading (line spacing), tracking (letter spacing), 
kerning (space between specific letter pairs), and baseline shift. 

•​ Paragraph panel – control alignment, indentation, and spacing before/after 
paragraphs. 

•​ Text on a path – place text along a curved line or shape by creating a path with the 
Pen Tool and then clicking on it with the Type Tool. 

•​ Warp text – apply preset distortion effects to text (arc, arch, wave, flag, etc.). 
•​ Layer styles on text – apply drop shadows, bevels, gradients, strokes, and glows to 

make text visually striking. 
 

💼 Case Study – Creating a Social Media Banner 

A small tech startup asks you to create a social media banner (1200 × 628 pixels) for their 
LinkedIn page announcing a new product launch. The banner must include: a background 
photograph, the company logo, a headline in bold typography, a tagline in lighter text, and 
a call-to-action button design. The overall style should be modern, clean, and 
professional. 

 
Task: Design the banner in Photoshop using at least 5 layers (background photo, logo, 
headline text, tagline text, button shape/text). Apply at least one adjustment layer (e.g. 
brightness/contrast or colour overlay on the background), one layer style (e.g. drop 
shadow on the text), and export the final result as both a PSD and a high-quality JPEG. 
Document your design decisions in a 300-word write-up. 

 

📝 Over to you – Video Watch: Photoshop Text Effects 
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Watch this YouTube video: 
Title: Photoshop Text Effects – 10 Awesome Text Effects in Photoshop – Satori Graphics 
Duration: 15:32 
Link: https://www.youtube.com/watch?v=DwKlMEHdU2c 

Watch and follow along with at least two of the text effects demonstrated. Save your 
results and reflect: which effects would be suitable for professional IT documentation, and 
which are more suited to creative marketing? 
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1.3 Creating illustrations using illustration software 

While Photoshop works primarily with raster (pixel-based) images, Adobe Illustrator is the 
industry-standard tool for creating vector graphics. Vector graphics are defined by 
mathematical equations rather than pixels, which means they can be scaled to any size 
without losing quality. This makes Illustrator the ideal tool for creating logos, icons, diagrams, 
infographics, and technical illustrations. 

 

📝 Over to you – Video Watch: Illustrator for Beginners 

Watch this YouTube video: 
Title: Adobe Illustrator for Beginners – Tutorial Course – Envato Tuts+ 
Duration: 42:16 
Link: https://www.youtube.com/watch?v=Ib8UBwu3yGA 

Watch the first 20 minutes covering the Illustrator workspace, artboards, and basic shape 
tools. Create a simple composition using three different geometric shapes with different fill 
colours. 

 
Raster vs Vector Graphics 

Understanding the difference between raster and vector graphics is fundamental: 

•​ Raster graphics – composed of pixels arranged in a grid. Each pixel has a specific 
colour value. Quality degrades when the image is enlarged (pixelation). Best for 
photographs and complex images with subtle colour gradients. Software: Photoshop, 
GIMP. 

•​ Vector graphics – composed of paths defined by mathematical equations (points, 
lines, curves). Can be scaled infinitely without quality loss. Best for logos, icons, 
illustrations, typography, and technical diagrams. Software: Illustrator, Inkscape, 
Figma. 

 
 

🧭 Did you know? 

Every font on your computer is a vector graphic. The letters are defined as mathematical 
outlines (Bézier curves), which is why text remains sharp at any size – from 6pt footnotes 
to 200pt headlines. When you create a logo in Illustrator, it uses the same principle, 
ensuring your design looks perfect on a business card and on a billboard. 

 
The Illustrator Workspace 

Illustrator’s workspace shares similarities with Photoshop but has important differences: 

•​ Artboards – the equivalent of pages or canvases. You can have multiple artboards in 
a single document, each with different dimensions (useful for designing a logo in 
multiple sizes, or creating a set of social media assets). 
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•​ Tools panel – includes selection tools, drawing tools (Pen, Pencil, Shape Builder), 
shape tools (Rectangle, Ellipse, Polygon, Star), text tools, and transformation tools. 

•​ Properties panel – provides context-sensitive controls for the selected object (fill, 
stroke, dimensions, alignment, effects). 

•​ Layers panel – similar to Photoshop but organises vector objects rather than pixel 
layers. 

•​ Appearance panel – controls the visual attributes (fills, strokes, effects, opacity) of 
selected objects. 

 
 
Selecting and Aligning Objects 

Precise selection and alignment are essential for professional design: 

•​ Selection Tool (V) – select, move, and resize objects by clicking or dragging a 
selection box. 

•​ Direct Selection Tool (A) – select and edit individual anchor points and path 
segments within an object. 

•​ Align panel – align objects relative to each other (left, centre, right, top, middle, 
bottom) or distribute them evenly. Essential for creating balanced, professional 
layouts. 

•​ Smart Guides – automatic alignment guides that appear as you move objects, 
showing distances and alignment to nearby objects. 

 
Creating and Editing Shapes 

Illustrator provides powerful shape creation tools: 

•​ Basic shapes – Rectangle (M), Ellipse (L), Polygon, Star, Line tools. Hold Shift while 
drawing to constrain proportions (e.g. perfect circle, perfect square). 
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•​ Shape Builder Tool – combine, subtract, and intersect overlapping shapes to create 
complex forms from simple ones. 

•​ Pathfinder panel – provides Boolean operations (Unite, Minus Front, Intersect, 
Exclude) for combining shapes. 

•​ Live Corners – drag corner widgets to add rounded corners to any rectangle or 
polygon. 

•​ Width Tool – vary the width of a stroke along its length to create organic, hand-drawn 
effects. 

 
Drawing with Pen and Pencil Tools 

The Pen Tool (P) is Illustrator’s most powerful and versatile drawing tool. It creates precise 
Bézier curves by placing anchor points and controlling curve handles. Mastering the Pen 
Tool is considered one of the most important skills in vector design: 

•​ Click to create straight-line segments (corner points). 
•​ Click and drag to create smooth curves (smooth points with direction handles). 
•​ Alt+click on a smooth point to convert it to a corner point. 
•​ Close a path by clicking on the starting anchor point. 

 
The Pencil Tool (N) creates freehand paths that Illustrator smooths automatically. It is less 
precise than the Pen Tool but faster for sketching organic shapes. 

 
Colour and Painting 

Illustrator offers sophisticated colour tools: 

•​ Fill and Stroke – every object has a fill (interior colour) and a stroke (outline). These 
can be solid colours, gradients, patterns, or none. 

•​ Colour panel and Swatches panel – select and save colours. Use the Colour Guide 
panel for colour harmony suggestions. 

•​ Gradient Tool (G) – create linear, radial, and freeform gradients with multiple colour 
stops. 

•​ Recolour Artwork – a powerful tool for changing the entire colour palette of an 
illustration in one operation. 

•​ Live Paint – fill enclosed regions of overlapping paths intuitively, similar to a colouring 
book. 

 
Working with Type 

Typography in Illustrator is highly flexible: 

•​ Point type and area type – point type for headlines and short text; area type for 
paragraphs within a defined text frame. 

•​ Type on a path – flow text along any open or closed path. 
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•​ Touch Type Tool – individually move, rotate, and scale individual characters within a 
text string. 

•​ Create Outlines – convert text to vector paths for custom typography and logo design 
(Type > Create Outlines). 

•​ Variable fonts – modern font technology that allows you to adjust weight, width, and 
other properties along a continuous range. 

 
Blending Colours and Shapes 

The Blend Tool (W) creates a series of intermediate objects between two shapes, with 
smooth transitions in colour, shape, and size. You can control the number of intermediate 
steps and the spacing. Blends are used for creating colour gradients along a custom path, 
generating smooth colour transitions between objects, and creating 3D-like effects. 

 

📝 Over to you – Logo Design Project 

Design a logo for a fictional IT consultancy company called ‘NexaByte Solutions’ using 
Adobe Illustrator (or the free alternative Inkscape). Your logo must: (1) use at least two 
geometric shapes combined using the Pathfinder or Shape Builder, (2) include the 
company name in a professional typeface, (3) use no more than three colours, and (4) be 
fully vector-based so it can scale to any size. Export your logo as an SVG, a 
high-resolution PNG, and a PDF. Write a 200-word rationale explaining your design 
choices. 
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1.4 Techniques to create movement in a graphical environment 

Static images are powerful, but adding movement and animation can dramatically enhance 
communication, engagement, and user experience. This section analyses the key 
techniques for creating the illusion of movement in graphical environments, from traditional 
animation principles to modern digital tools. 

 
Principles of Animation 

The foundational principles of animation were first articulated by Disney animators Ollie 
Johnston and Frank Thomas in 1981. Several of these principles are directly relevant to 
digital graphics and UI animation: 

•​ Squash and stretch – deforming objects to convey weight, flexibility, and impact. In UI 
design, this might be a button that subtly compresses when pressed. 

•​ Anticipation – a preparatory action that signals what is about to happen. In web 
design, a subtle grow effect on a button before a page transition. 

•​ Staging – presenting an idea clearly so the audience understands it. In UI, this 
means using animation to draw attention to the most important element. 

•​ Easing (slow in, slow out) – natural movement accelerates gradually and decelerates 
before stopping. In CSS and JavaScript, this is implemented through easing 
functions (ease-in, ease-out, ease-in-out). 

•​ Follow-through and overlapping action – different parts of an object move at different 
rates. In UI, a panel might slide in while its contents fade in slightly later. 

•​ Timing – the speed of an action communicates its weight and importance. Fast 
animations feel snappy and responsive; slow animations feel deliberate and 
dramatic. 

 

📝 Over to you – Video Watch: 12 Principles of Animation 

Watch this YouTube video: 
Title: 12 Principles of Animation (Official Full Series) – AlanBeckerTutorials 
Duration: 45:34 
Link: https://www.youtube.com/watch?v=uDqjIdI4bF4 

Watch and note how each principle could be applied to user interface design. Choose 
three principles and describe a specific UI animation example for each. 

 
Digital Animation Techniques 

Modern digital tools offer several approaches to creating movement: 

•​ Frame-by-frame animation – each frame is drawn individually, creating the illusion of 
movement when played in sequence. Photoshop’s Timeline panel supports 
frame-by-frame GIF animation. 

19 



 

•​ Tweening (in-betweening) – the software automatically generates intermediate 
frames between two keyframes. You define the start and end states, and the software 
interpolates the transition. Used in Adobe Animate, After Effects, and CSS 
animations. 

•​ Motion paths – objects follow a defined path through space. Used extensively in 
presentation software (PowerPoint, Keynote) and animation tools. 

•​ Parallax scrolling – background elements move at different speeds to foreground 
elements, creating an illusion of depth. Widely used in modern web design. 

•​ CSS animations and transitions – web developers use CSS @keyframes and 
transition properties to animate HTML elements directly in the browser, enabling 
responsive, performant UI animations. 

•​ JavaScript animation libraries – libraries like GSAP (GreenSock Animation Platform), 
Framer Motion, and Lottie enable sophisticated web animations with precise control. 

•​ Sprite animation – a sprite sheet contains multiple frames of an animation in a single 
image. The software displays each frame in sequence. Widely used in web and 
game development. 

 

🌍 Industry Insight – Motion Design in UX 

Motion design has become a critical element of modern user experience (UX). Google’s 
Material Design guidelines include detailed specifications for animation 
(https://m3.material.io/styles/motion/overview), recommending standard durations, easing 
curves, and transition patterns. Apple’s Human Interface Guidelines similarly emphasise 
the role of animation in providing feedback, maintaining context during transitions, and 
guiding attention. Companies like Airbnb have developed their own animation libraries 
(Lottie) to enable designers to create rich, performant animations that work across 
platforms. 

Visit: https://lottiefiles.com/ to explore a vast library of free, lightweight animations for web 
and mobile apps. 

 
Preparing Files for the Web 

When creating graphics for web use, optimisation is essential. Large, unoptimised images 
slow down page loading times, increasing bounce rates and reducing search engine 
rankings: 

•​ Image formats – use JPEG for photographs, PNG for graphics requiring 
transparency, SVG for vector graphics (logos, icons), WebP for modern browsers 
(smaller file sizes than JPEG and PNG with comparable quality), and GIF or 
animated WebP for simple animations. 

•​ Compression – reduce file size without visibly reducing quality. Photoshop’s Export 
As (File > Export > Export As) and Save for Web (legacy) dialogs allow you to control 
quality settings and preview the result. 
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•​ Responsive images – create multiple sizes of the same image for different screen 
sizes (mobile, tablet, desktop). Use the HTML srcset attribute to serve the 
appropriate version. 

•​ Image dimensions – never use an image that is larger than it needs to be on screen. 
A hero image displayed at 1200px wide should not be a 5000px original. 

 

📝 Over to you – Animation Activity 

Using Photoshop’s Timeline panel (Window > Timeline), create a simple 5-frame animated 
GIF of a bouncing ball. Apply the ‘squash and stretch’ principle to make the animation feel 
realistic. Alternatively, if you prefer web development, create the same bouncing ball 
animation using CSS @keyframes. Save/export your result and write a 200-word 
explanation of which animation principles you applied and why. 

 
 

21 



 

Reading List 

•​ Adobe Press (2023). Adobe Photoshop Classroom in a Book (2024 Release). San 
Jose, CA: Adobe Press. 

•​ Adobe Press (2023). Adobe Illustrator Classroom in a Book (2024 Release). San 
Jose, CA: Adobe Press. 

•​ Evening, M. (2023). Adobe Photoshop CC for Photographers: 2024 Edition. 
Abingdon: Routledge. 

•​ Gyncild, B. & Howell, L. (2023). Adobe Illustrator Classroom in a Book. San Jose, 
CA: Adobe Press. 

•​ Negrino, T. & Smith, D. (2023). Photoshop CC: Visual QuickStart Guide. San 
Francisco, CA: Peachpit Press. 

•​ Wood, B. (2024). Adobe Illustrator CC: The Complete Guide. San Jose, CA: Adobe 
Press. 

 

Summary 

In this chapter, you have explored the practical skills of computer graphics editing. You have 
studied the fundamentals of digital images, including resolution, colour modes, and file 
formats. You have learned to apply photo editing, retouching, and repairing techniques using 
tools such as the Clone Stamp, Healing Brush, and Content-Aware Fill. You have explored 
Photoshop’s creative capabilities including layers, masks, channels, filters, and typographic 
design. You have developed illustration skills using Adobe Illustrator, including shape 
creation, the Pen Tool, colour management, and blending. Finally, you have analysed 
techniques for creating movement in graphical environments, from animation principles to 
CSS and JavaScript animation tools. These visual communication skills complement your 
technical IT knowledge and prepare you for roles that require both creative and technical 
competence. 
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Chapter Two – Database Concepts and SQL 

Introduction 

This chapter introduces the fundamental concepts of database systems, one of the most 
important topics in information technology. Virtually every modern application – from 
websites and mobile apps to enterprise resource planning (ERP) systems and data analytics 
platforms – relies on a database to store, organise, and retrieve data. 

 
You will study the concept of a relational database, learn to design databases using 
entity-relationship (ER) modelling and normalisation, and develop practical skills in creating 
and manipulating databases using Structured Query Language (SQL). By the end of this 
chapter, you will be able to design a well-structured relational database and write SQL 
queries to create, populate, query, and modify data. 

 

Learning Outcomes 

On completing the chapter, you will be able to: 

1.​ Create a database system. 
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Assessment Criteria 

2.1 Define the concept of a relational database. 

2.2 Build an entity-relationship diagram, deriving relations and validating relations using 
normalisation. 

2.3 Create a database using Data Definition Language (DDL) and manipulate a database 
using Data Manipulation Language (DML) that meets the specification. 
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2.1 The concept of a relational database 

📝 Over to you – Video Watch: What is a Database? 

Watch this YouTube video: 
Title: What is a Database? – Lucidchart 
Duration: 5:47 
Link: https://www.youtube.com/watch?v=wR0jg0eQsZA 

After watching, explain in your own words what a database is and why flat-file systems are 
inadequate for most modern applications. 

 
Data, Information and Database Management 

Before exploring databases, it is important to distinguish between data and information. Data 
consists of raw, unprocessed facts and figures (e.g. ‘42’, ‘Smith’, ‘15/03/2026’). Information is 
data that has been processed, organised, and given context so that it becomes meaningful 
and useful (e.g. ‘Customer John Smith placed order #42 on 15 March 2026’). 

 
A database is a structured, organised collection of related data stored electronically. A 
Database Management System (DBMS) is the software that provides the interface between 
the users and the database, handling data storage, retrieval, security, backup, and 
concurrent access. Popular DBMS products include MySQL, PostgreSQL, Microsoft SQL 
Server, Oracle Database, SQLite, and MariaDB. 
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The Relational Model 

The relational database model, proposed by Edgar F. Codd in 1970, organises data into 
tables (called relations). Each table represents an entity (e.g. Customers, Orders, Products), 
and the tables are linked through shared attributes called keys. This model remains the 
dominant approach to database design over 50 years after its invention. 

 
Key terminology: 

•​ Table (Relation) – a two-dimensional structure consisting of rows and columns that 
stores data about a specific entity. 

•​ Row (Tuple/Record) – a single instance of the entity (e.g. one customer, one order). 
•​ Column (Attribute/Field) – a specific property of the entity (e.g. CustomerName, 

Email, DateOfBirth). 
•​ Primary Key (PK) – a column (or combination of columns) that uniquely identifies 

each row in a table. Every table must have a primary key. Examples: CustomerID, 
OrderNumber, ISBN. 

•​ Foreign Key (FK) – a column in one table that references the primary key of another 
table, creating a relationship between the two tables. 

•​ Candidate Key – any column or combination of columns that could serve as a 
primary key (unique and not null). 

•​ Composite Key – a primary key consisting of two or more columns. 
 

💡 Example – A Simple Relational Database 

Consider a simple online bookshop with three tables: 

 
Customers: CustomerID (PK), FirstName, LastName, Email 

Books: ISBN (PK), Title, Author, Price 

Orders: OrderID (PK), CustomerID (FK), ISBN (FK), OrderDate, Quantity 

 
The Orders table links Customers to Books through foreign keys. CustomerID in Orders 
references CustomerID in Customers; ISBN in Orders references ISBN in Books. This 
allows you to answer questions like ‘Which books has customer John Smith ordered?’ by 
joining the tables. 

 
Types of Relationships 

Relationships between tables can be classified as: 

•​ One-to-one (1:1) – one record in Table A is associated with exactly one record in 
Table B. Example: each employee has exactly one company car. 

•​ One-to-many (1:M) – one record in Table A can be associated with many records in 
Table B, but each record in Table B is associated with only one record in Table A. 
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This is the most common type. Example: one customer can place many orders, but 
each order belongs to one customer. 

•​ Many-to-many (M:N) – records in Table A can be associated with many records in 
Table B, and vice versa. This requires a junction table (also called a linking table or 
bridge table) to resolve the relationship. Example: students can enrol in many 
modules, and each module can have many students – resolved with an Enrolment 
table. 

 

🧭 Did you know? 

Edgar F. Codd’s 1970 paper ‘A Relational Model of Data for Large Shared Data Banks’ is 
one of the most influential papers in the history of computing. Codd, working at IBM, 
proposed that data should be organised into tables with relationships defined by shared 
values, rather than stored in hierarchical or network structures. IBM was initially reluctant 
to implement his ideas (they had invested heavily in hierarchical databases), so a group at 
UC Berkeley built the first relational DBMS prototype, called Ingres, which eventually led 
to PostgreSQL. Oracle also implemented an early commercial version, and the relational 
model has dominated database technology ever since. 

 
Advantages of Relational Databases 

•​ Data integrity – constraints (primary keys, foreign keys, unique, not null, check) 
enforce data quality and consistency. 

•​ Reduced redundancy – normalisation eliminates unnecessary duplication of data. 
•​ Flexibility – data can be queried and combined in ways not anticipated at design time 

using SQL. 
•​ Security – DBMS products offer granular access control (permissions on tables, 

views, and individual operations). 
•​ Concurrent access – multiple users can access the database simultaneously with 

transaction management ensuring data consistency (ACID properties: Atomicity, 
Consistency, Isolation, Durability). 

•​ Standardised query language – SQL is the universal language for relational 
databases, meaning skills are transferable across different DBMS products. 

 

📝 Over to you – Database Identification 

Think of three real-world systems that use databases (e.g. an online shopping website, a 
university enrolment system, a hospital patient records system). For each, identify at least 
three entities (tables) and the likely relationships between them. Draw a simple diagram 
showing the tables and their connections. Write a 200-word explanation for one of your 
examples. 
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2.2 Entity-relationship diagrams, relations and normalisation 

Designing a well-structured database is critical. A poorly designed database leads to data 
redundancy (the same data stored in multiple places), update anomalies (inconsistencies 
when data is modified), and difficulty querying the data. Entity-relationship (ER) modelling 
and normalisation are the two key techniques for ensuring a good design. 

 

📝 Over to you – Video Watch: ER Diagrams 

Watch this YouTube video: 
Title: Entity Relationship Diagram (ERD) Tutorial – Lucidchart 
Duration: 11:16 
Link: https://www.youtube.com/watch?v=QpdhBUYk7Kk 

After watching, draw an ER diagram for a simple library system with entities for Books, 
Members, and Loans. Include primary keys, attributes, and relationship lines with 
cardinality notation. 

 
Entity-Relationship Modelling 

An entity-relationship (ER) diagram is a visual representation of the data structure, showing 
entities, their attributes, and the relationships between them. ER diagrams are created 
during the design phase, before any tables are built in the database. 

 
Key components of an ER diagram: 

•​ Entities – represented as rectangles. Each entity becomes a table in the database. 
Example: Student, Module, Lecturer. 

•​ Attributes – represented as ovals connected to their entity. Each attribute becomes a 
column. The primary key attribute is underlined. Example: StudentID (PK), 
FirstName, LastName, DateOfBirth. 

•​ Relationships – represented as diamonds connecting entities, with cardinality 
notation (1:1, 1:M, M:N) showing how many instances of one entity relate to another. 

•​ Participation constraints – total participation (double line) means every instance must 
participate in the relationship; partial participation (single line) means participation is 
optional. 
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Deriving Relations from ER Diagrams 

Once you have created an ER diagram, you convert it into a set of relational tables (called 
‘deriving relations’): 

•​ Each entity becomes a table with its attributes as columns and its primary key. 
•​ One-to-many relationships are implemented by adding the primary key of the ‘one’ 

side as a foreign key in the ‘many’ side table. 
•​ Many-to-many relationships require a new junction table containing the primary keys 

of both entities as a composite primary key (and foreign keys). 
•​ One-to-one relationships are implemented by adding the primary key of one table as 

a foreign key in the other (usually the table with optional participation). 
 
Normalisation 

Normalisation is the process of structuring a relational database to reduce data redundancy 
and improve data integrity. It involves applying a series of ‘normal forms’ (rules) to your table 
designs: 

 
First Normal Form (1NF) 

A table is in 1NF if: (1) each column contains only atomic (indivisible) values – no lists, sets, 
or repeating groups, and (2) each column has a unique name and each row is unique (has a 
primary key). For example, a column ‘PhoneNumbers’ containing ‘01234, 05678’ violates 
1NF. The solution is to create a separate PhoneNumbers table. 

 
Second Normal Form (2NF) 

A table is in 2NF if it is in 1NF and every non-key attribute is fully functionally dependent on 
the entire primary key (not just part of it). This only applies to tables with composite primary 
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keys. For example, if a table has a composite key (StudentID, ModuleID) and contains 
‘ModuleName’, this attribute depends only on ModuleID (not on StudentID), so it should be 
moved to a separate Module table. 

 
Third Normal Form (3NF) 

A table is in 3NF if it is in 2NF and no non-key attribute depends on another non-key 
attribute (no transitive dependencies). For example, if a Student table contains ‘TutorID’ and 
‘TutorName’, the TutorName depends on TutorID (not directly on the primary key StudentID). 
The solution is to create a separate Tutor table and reference it with a foreign key. 

 

💡 Example – Normalisation Process 

Unnormalised data (single flat table): 

OrderID | CustomerName | CustomerEmail | Product1 | Price1 | Product2 | Price2 

 
Problems: repeating groups (Product1/Product2), redundancy (customer data repeated for 
each order). 

 
After 1NF: Remove repeating groups → OrderID, CustomerName, CustomerEmail, 
ProductName, Price 

After 2NF: Split into Orders (OrderID, CustomerName, CustomerEmail) and OrderItems 
(OrderID, ProductName, Price) 

After 3NF: Extract customer details → Customers (CustomerID, CustomerName, 
CustomerEmail), Orders (OrderID, CustomerID), OrderItems (OrderItemID, OrderID, 
ProductName, Price) 

 

💼 Case Study – University Database Design 

A university needs a database to manage students, modules, lecturers, and enrolments. 
The following information must be stored: student details (ID, name, email, date of birth, 
programme), module details (code, title, credits, level), lecturer details (ID, name, email, 
office), which lecturer teaches which module, and which students are enrolled on which 
modules (including the grade achieved). 

 
Task: (1) Draw a complete ER diagram with entities, attributes, primary keys, 
relationships, and cardinality. (2) Derive the relational tables from your ER diagram. (3) 
Demonstrate that your tables are in 3NF by checking for 1NF, 2NF, and 3NF violations. 
Present your work as a structured report. 

 

30 



 

2.3 Creating and manipulating a database using DDL and DML 

Structured Query Language (SQL) is the standard language for interacting with relational 
databases. SQL is divided into several sub-languages, the two most important of which are 
Data Definition Language (DDL) for creating and modifying database structures, and Data 
Manipulation Language (DML) for inserting, querying, updating, and deleting data. 

 

📝 Over to you – Video Watch: SQL Tutorial for Beginners 

Watch this YouTube video: 
Title: SQL Tutorial – Full Database Course for Beginners – freeCodeCamp 
Duration: 4:20:38 
Link: https://www.youtube.com/watch?v=HXV3zeQKqGY 

Watch the first 30 minutes covering database basics, SQL syntax, and CREATE TABLE. 
Then practise by setting up a free MySQL database at https://www.db-fiddle.com/ and 
creating a simple table. 

 
Data Definition Language (DDL) 

DDL commands define and modify the structure of the database: 

 
CREATE TABLE 

Creates a new table with specified columns, data types, and constraints: 

CREATE TABLE Customers ( 

    CustomerID INT PRIMARY KEY AUTO_INCREMENT, 

    FirstName VARCHAR(50) NOT NULL, 

    LastName VARCHAR(50) NOT NULL, 

    Email VARCHAR(100) UNIQUE NOT NULL, 

    DateOfBirth DATE, 

    RegistrationDate DATETIME DEFAULT CURRENT_TIMESTAMP 

); 

 
Common data types include: INT (integer), VARCHAR(n) (variable-length text up to n 
characters), CHAR(n) (fixed-length text), DATE, DATETIME, DECIMAL(p,s) (precise decimal 
numbers), BOOLEAN, and TEXT (long text). 

 
Common constraints include: PRIMARY KEY, FOREIGN KEY, NOT NULL, UNIQUE, 
DEFAULT, CHECK, and AUTO_INCREMENT (automatically generates unique integer 
values). 

 
ALTER TABLE 
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Modifies an existing table’s structure: 

ALTER TABLE Customers ADD COLUMN Phone VARCHAR(20); 

ALTER TABLE Customers DROP COLUMN DateOfBirth; 

ALTER TABLE Customers MODIFY COLUMN Email VARCHAR(150); 

 
DROP TABLE 

Permanently deletes a table and all its data: 

DROP TABLE Customers; 

 
CREATE INDEX 

Creates an index on one or more columns to speed up queries: 

CREATE INDEX idx_customer_email ON Customers(Email); 

 
Data Manipulation Language (DML) 

DML commands work with the data stored in tables: 

 
INSERT INTO 

Adds new rows to a table: 

INSERT INTO Customers (FirstName, LastName, Email) 

VALUES (‘John’, ‘Smith’, ‘john.smith@email.com’); 

 
SELECT 

Retrieves data from one or more tables. This is the most frequently used SQL command: 

SELECT FirstName, LastName, Email FROM Customers; 

SELECT * FROM Customers WHERE LastName = ‘Smith’; 

SELECT * FROM Customers ORDER BY LastName ASC; 

SELECT COUNT(*) FROM Customers; 

 
WHERE Clause and Operators 

The WHERE clause filters results based on conditions: 

•​ Comparison operators: =, <>, <, >, <=, >= 
•​ Logical operators: AND, OR, NOT 
•​ Pattern matching: LIKE (‘%’ matches any string, ‘_’ matches any single character) 
•​ Range: BETWEEN ... AND ... 
•​ Set membership: IN (‘value1’, ‘value2’, ...) 
•​ NULL check: IS NULL, IS NOT NULL 
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JOIN Operations 

JOINs combine rows from two or more tables based on a related column: 

SELECT Customers.FirstName, Orders.OrderDate, Books.Title 

FROM Customers 

INNER JOIN Orders ON Customers.CustomerID = Orders.CustomerID 

INNER JOIN Books ON Orders.ISBN = Books.ISBN; 

 
Types of JOIN: INNER JOIN (only matching rows), LEFT JOIN (all rows from the left table 
plus matching rows from the right), RIGHT JOIN (all rows from the right table), and FULL 
OUTER JOIN (all rows from both tables). 

 
UPDATE 

Modifies existing data: 

UPDATE Customers SET Email = ‘new.email@example.com’ WHERE CustomerID = 1; 

 
DELETE 

Removes rows from a table: 

DELETE FROM Customers WHERE CustomerID = 1; 

 
Aggregate Functions and GROUP BY 

Aggregate functions perform calculations on sets of rows: 

•​ COUNT() – counts the number of rows 
•​ SUM() – calculates the total of a numeric column 
•​ AVG() – calculates the average 
•​ MIN() / MAX() – finds the minimum/maximum value 

 
GROUP BY groups rows that share a value, allowing aggregates to be calculated per group: 

SELECT CustomerID, COUNT(*) AS TotalOrders FROM Orders GROUP BY CustomerID; 

 
HAVING filters groups (like WHERE, but for grouped results): 

SELECT CustomerID, COUNT(*) AS TotalOrders FROM Orders GROUP BY CustomerID 
HAVING COUNT(*) > 5; 

 

🌍 Industry Insight – SQL in the Real World 

SQL is consistently ranked as one of the most in-demand technical skills in the IT job 
market. According to Stack Overflow’s 2024 Developer Survey, SQL is used by 
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approximately 52% of all developers, making it the third most popular language after 
JavaScript and HTML/CSS. It is essential for roles including database administrator, data 
analyst, backend developer, business intelligence analyst, and data engineer. Mastering 
SQL is one of the highest-return investments you can make in your IT career. 

Practice: Try free interactive SQL courses at https://sqlbolt.com/ and 
https://www.w3schools.com/sql/ 

 

💼 Case Study – E-Commerce Database 

An e-commerce company needs a database with the following tables: Customers 
(CustomerID, FirstName, LastName, Email, City), Products (ProductID, ProductName, 
Category, Price, StockQuantity), and Orders (OrderID, CustomerID, ProductID, Quantity, 
OrderDate). 

 
Task: Write SQL statements to: (1) CREATE all three tables with appropriate data types, 
primary keys, foreign keys, and constraints. (2) INSERT at least 5 rows into each table. (3) 
Write SELECT queries to find: (a) all orders placed by a specific customer, (b) the total 
revenue generated (sum of Price × Quantity), (c) the top 3 best-selling products by 
quantity, (d) customers who have not placed any orders (using a LEFT JOIN). Test your 
queries on https://www.db-fiddle.com/ and submit screenshots of the results. 

 

📝 Over to you – SQL Practice 

Visit https://sqlbolt.com/ and complete Lessons 1 through 12. For each lesson, note the 
SQL command learned and write one original query that demonstrates the concept. 
Compile your queries in a single document with explanations. 
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Summary 

In this chapter, you have explored the fundamental concepts of relational databases, 
including the relational model, tables, keys, and relationships. You have learned to design 
databases using entity-relationship diagrams and to validate your designs through 
normalisation to first, second, and third normal forms. You have developed practical SQL 
skills, using Data Definition Language (DDL) to create and modify database structures and 
Data Manipulation Language (DML) to insert, query, update, and delete data. You have 
practised writing SELECT queries with WHERE clauses, JOINs, aggregate functions, and 
GROUP BY. These database skills are among the most transferable and in-demand 
competencies in the IT industry, applicable to virtually every domain from web development 
to data analytics to enterprise systems. 
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Glossary 

Word / Term Explanation 

Alpha Channel A custom selection stored as a grayscale image within an 
image file, used for transparency and complex masking. 

Anchor Point A point on a Bézier path that defines the position and curvature 
of the path segment. 

Attribute A property or characteristic of an entity in a database 
(becomes a column in a table). 

Bézier Curve A mathematically defined curve used in vector graphics, 
controlled by anchor points and direction handles. 

Blending Mode A setting that determines how a layer’s pixels interact with the 
pixels on layers below. 

CMYK Cyan, Magenta, Yellow, Key (Black); the colour model used for 
print production. 

Candidate Key Any column or combination of columns that could uniquely 
identify a row in a table. 

Clone Stamp A Photoshop tool that copies pixels from a source area and 
paints them onto a target area. 

Composite Key A primary key consisting of two or more columns. 

Content-Aware Fill An AI-powered Photoshop feature that intelligently fills selected 
areas based on surrounding content. 

Data Definition Language (DDL) SQL commands used to define or modify database structure 
(CREATE, ALTER, DROP). 

Data Manipulation Language 
(DML) 

SQL commands used to manipulate data (SELECT, INSERT, 
UPDATE, DELETE). 

DBMS Database Management System; software that manages the 
storage, retrieval, and security of data in a database. 

DPI Dots Per Inch; a measure of image resolution for print output. 

Entity A real-world object or concept represented as a table in a 
relational database. 

Entity-Relationship Diagram A visual model showing entities, attributes, and relationships in 
a database design. 

Foreign Key A column in one table that references the primary key of 
another table. 

Gradient A smooth transition between two or more colours. 

Healing Brush A Photoshop tool that repairs imperfections by blending copied 
pixels with surrounding areas. 

JOIN An SQL operation that combines rows from two or more tables 
based on a related column. 

JPEG A lossy image compression format ideal for photographs. 

Layer A transparent sheet in Photoshop on which image elements 
are placed for non-destructive editing. 
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Layer Mask A grayscale image attached to a layer that controls the visibility 
of different areas. 

Normalisation The process of organising a database to reduce redundancy 
and improve data integrity. 

Pen Tool Illustrator and Photoshop’s primary tool for creating precise 
Bézier paths. 

PNG A lossless image format that supports transparency, ideal for 
web graphics. 

Primary Key A column that uniquely identifies each row in a database table. 

Raster Graphics Images composed of pixels arranged in a grid (e.g. 
photographs). Quality degrades when enlarged. 

Relational Database A database organised into tables with relationships defined by 
shared key values. 

Resolution The number of pixels in an image, determining its detail and 
quality. 

RGB Red, Green, Blue; the colour model used for screen display. 

SQL Structured Query Language; the standard language for 
interacting with relational databases. 

SVG Scalable Vector Graphics; an XML-based vector image format 
for the web. 

Vector Graphics Images defined by mathematical paths that can be scaled 
without quality loss. 
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MCQs and True & False Questions (self-assessment) 

True or False Questions 

 
1. A raster image is composed of pixels. 

2. Vector graphics lose quality when scaled up. 

3. CMYK is the colour mode used for screen display. 

4. The Clone Stamp tool automatically blends copied pixels with the surroundings. 

5. Layers allow non-destructive editing in Photoshop. 

6. A layer mask uses black to show and white to hide areas. 

7. The Pen Tool in Illustrator creates Bézier curves. 

8. SVG is a raster image format. 

9. 300 DPI is the standard resolution for high-quality print. 

10. CSS @keyframes can be used to create web animations. 

11. A primary key can contain duplicate values. 

12. SQL stands for Structured Query Language. 

13. A foreign key references the primary key of another table. 

14. Normalisation increases data redundancy. 

15. In 1NF, each column must contain atomic values. 

16. A many-to-many relationship requires a junction table. 

17. SELECT is a DDL command. 

18. The WHERE clause filters rows in a SELECT query. 

19. INNER JOIN returns only rows that have matching values in both tables. 

20. DROP TABLE only deletes data, not the table structure. 
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Multiple Choice Questions 

 
1. Which colour mode is used for screen display? 

A. CMYK 

B. RGB 

C. Grayscale 

D. Pantone 

 
2. What does DPI stand for? 

A. Data Per Inch 

B. Dots Per Inch 

C. Digital Pixel Index 

D. Display Per Image 

 
3. Which Photoshop tool removes blemishes by blending with surroundings? 

A. Clone Stamp 

B. Eraser 

C. Healing Brush 

D. Pen Tool 

 
4. What is a layer mask? 

A. A filter effect 

B. A grayscale image controlling visibility 

C. A colour adjustment 

D. A selection tool 

 
5. Which file format supports transparency? 

A. JPEG 

B. TIFF 

C. PNG 

D. BMP 

 
6. The Pen Tool creates: 

A. Pixel-based drawings 

B. Bézier paths 
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C. Text effects 

D. Gradient fills 

 
7. Which tool combines overlapping shapes in Illustrator? 

A. Eraser 

B. Blend 

C. Shape Builder 

D. Gradient 

 
8. Tweening in animation refers to: 

A. Drawing each frame manually 

B. Generating intermediate frames automatically 

C. Adding sound effects 

D. Compressing file size 

 
9. A relational database organises data into: 

A. Files and folders 

B. Tables with rows and columns 

C. Tree structures 

D. Flat text files 

 
10. A primary key must be: 

A. A number 

B. Unique and not null 

C. A foreign key 

D. An integer 

 
11. Which SQL command creates a new table? 

A. INSERT 

B. SELECT 

C. CREATE TABLE 

D. UPDATE 

 
12. What does a foreign key do? 

A. Encrypts data 
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B. Links two tables through a reference 

C. Deletes duplicate rows 

D. Sorts data 

 
13. Which normal form eliminates repeating groups? 

A. 1NF 

B. 2NF 

C. 3NF 

D. BCNF 

 
14. The SELECT statement is part of: 

A. DDL 

B. DML 

C. DCL 

D. TCL 

 
15. An INNER JOIN returns: 

A. All rows from both tables 

B. Only matching rows 

C. Only non-matching rows 

D. The first 10 rows 

 
16. Which aggregate function calculates the average? 

A. SUM() 

B. COUNT() 

C. AVG() 

D. MAX() 

 
17. In a many-to-many relationship, the junction table contains: 

A. No keys 

B. Only one foreign key 

C. Foreign keys from both tables 

D. Only text data 

 
18. Which constraint ensures a column cannot be empty? 
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A. UNIQUE 

B. DEFAULT 

C. NOT NULL 

D. CHECK 

 
19. Content-Aware Fill uses: 

A. Manual pixel copying 

B. AI to analyse surrounding content 

C. A predefined pattern 

D. A gradient 

 
20. GROUP BY is used with: 

A. INSERT statements 

B. Aggregate functions 

C. DROP commands 

D. ALTER TABLE 
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Answers to True/False Questions 

 
1. True. Raster images are composed of pixels arranged in a grid. 

2. False. Vector graphics can be scaled infinitely without quality loss. 

3. False. CMYK is for print; RGB is for screen display. 

4. False. The Clone Stamp copies pixels directly; the Healing Brush blends automatically. 

5. True. Layers allow you to edit elements independently without altering the original. 

6. False. In a layer mask, white shows and black hides areas. 

7. True. The Pen Tool creates mathematically defined Bézier curves. 

8. False. SVG (Scalable Vector Graphics) is a vector format. 

9. True. 300 DPI is the industry standard for high-quality print output. 

10. True. CSS @keyframes define animation sequences for web elements. 

11. False. A primary key must be unique for every row in the table. 

12. True. SQL stands for Structured Query Language. 

13. True. A foreign key creates a relationship by referencing another table’s primary key. 

14. False. Normalisation reduces data redundancy, not increases it. 

15. True. 1NF requires all column values to be atomic (indivisible). 

16. True. M:N relationships are resolved with a junction table containing foreign keys from 
both entities. 

17. False. SELECT is a DML command; DDL includes CREATE, ALTER, DROP. 

18. True. WHERE specifies conditions to filter rows returned by a query. 

19. True. INNER JOIN returns only rows with matching values in both tables. 

20. False. DROP TABLE deletes both the data and the table structure permanently. 

 
Answers to Multiple Choice Questions 

 
1. (B) RGB 

2. (B) Dots Per Inch 

3. (C) Healing Brush 

4. (B) A grayscale image controlling visibility 

5. (C) PNG 

6. (B) Bézier paths 

7. (C) Shape Builder 

8. (B) Generating intermediate frames automatically 
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9. (B) Tables with rows and columns 

10. (B) Unique and not null 

11. (C) CREATE TABLE 

12. (B) Links two tables through a reference 

13. (A) 1NF 

14. (B) DML 

15. (B) Only matching rows 

16. (C) AVG() 

17. (C) Foreign keys from both tables 

18. (C) NOT NULL 

19. (B) AI to analyse surrounding content 

20. (B) Aggregate functions 
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